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1. Outline 

【Figure 1.1】 NVCap Previewing Window 

 

Capture software “NVCap” is a program on Windows that works on the environment using UVC capture board 

“SVM-03U” (SVM board), made by NetVision Corp. This program has simple user interface to preview/capture 

video shown as 【Figure1.1】. In addition, the NVCap can record video as .avi format and control the target sensor 

and the SVM board. 

The “NVCap” software is corresponding to not only single channel capturing using one SVM board but also multi 

channel capturing using multiple SVM boards up to 4ch. Block diagram of multi channel SVM-03U based capture 

environment is shown as 【Figure 1.2】. In this figure, two SVM-03 boards are conneted to one PC are connected 

through USB3.0 cable in this configuration to optimize the load. Optionally, it is able to synchronize start/end 

timing for recording between multiple SVM-03 boards by using wiring. Recording multi-channel HD image is 

possible by using high performance PC and SSD (Solid State Disk). Many kinds of digital image sensor can be 

captured by SVM boards and NVCap application. 
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【Figure 1.2】 SVM-03U 4ch Capture Environment Configuration Example 

 

 This software is able not only to capture/record video image but to transmit camera setting through I2C and 

start capturing using external trigger signal (synchronized capturing). These functions are extension; installing 

“Extension Unit DLL” is required to use these extension function. How to install DLL is referred to the 3rd chapter. 

To use this software installing hardware driver is not required. 

 

- When you use USB3.0 hub (or PC card-based USB3.0 controller), operating instability is caused depending on a 

USB controller mounted on the hub. We recommend to use USB controller of TI Company. 
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【Figure 2.2】 Software Block Diagram 

 

 Software block diagram is shown on 【Figure 2.2】. “NVCap” and “Extension Unit DLL” is on the figure are the 

composition of the software. 

 As shown on the figure, NVCap has capturing video data function, saving function and I2C transceiver function. 

Capturing and saving are available by OS standard driver. I2C transceiver to sensor etc is done through extension 

unit. It is done in the framework of DirectShow by way of Windows standard driver through our original “Extension 

Unit DLL” installed in the PC. 

 For detailed information etc of SVM-03U board, refer to attached summary specifications. 

  



NVCap Software Manual 

NDC00046-V1.21 

 

 6 

 

2. Install and Uninstall 

2.1. How to Install 

2.1.1. Install “NVCap” Software 

【Figure2.3】 File list 

（Date of modification, size is different for version） 

 

 Currently there is no installer. Copy "NVCap.exe" and "NVExtensionPlugin.dll" in the "NVCap" folder in the CD 

into appropriate folder on your PC. Installation is finished just copying these files. To run NVCap application click 

(or lounch) “NVCap.exe”. 

If you would use “Extension Unit DLL” prease refer section 2.1.2. 

  

 “Microsoft Visual C++ Redistributable Package(x86)” and “Microsoft Visual C++ SP1 Redistributable 

Package(x86)” that Microsoft provide to us is required to operate program. If these programs are not installed in 

your PC, you need to install separately. For details, refer to web page of Microsoft. 

 

2.1.2. Install “Extension Unit DLL” 

1. Run “Command prompt” as administrator. 
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2. Move the current folder by cd command into where NVCap is installed. 

 

- Note that the destination directory may be differ in your environment. 

3. Register DLL to PC by “regsvr32 NVExtensionPlugin.dll”. 

4. If the following dialog are displayed, installation of Extension Unit DLL is succeeded. 
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2.2. How to Uninstall 

2.2.1. Uninstall of “NVCap” Software 

 Uninstallation is finished by deleting file copied on chapter2.2. You need to uninstall “Extension Unit 

DLL” previously if “Extension Unit DLL” is installed. (Refer to 2.2.2) 

 

2.2.2. Uninstall “Extension Unit DLL” 

1. Move to folder that NVExtensionPlugin.dll is existing by similar procedures of chapter 2.1.2  

2. Unregister DLL from PC by commanding “regsvr32 /u NVExtensionPlugin.dll”. 

3. If the following dialog are displayed, uninstallation process is succeeded. 
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3. Capture Software for SVM-03U (NVCap) Detailed Description 

 Capture Software for SVM-03U (NVCap) is GUI software for Windows 7/8 that has function of 

previewing and saving image that captured by SVM board up to 4ch. 

 

3.1. NVCap Window Explanation 

【Figure 3.1】 NVCap Main Window 

 

 As shown on Figure 3.1, main window is simple that is constructed with menu bar, picture view area, 

and status bar. In picture view area, image from device is displayed at one area in case of connecting 

one device, divided for four sub areas in case of connecting multiple device. 

 Corresponding of camera number that is set by device setting  （File -> Settings...） , picture view 

area and  status bar is shown on 【Figure 3.2】. 
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【Figure 3.2】 Corresponding of Multi Channel Chaptering 
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3.2. Menu List 

 File 

 Settings... Show Option Setting dialog. 

 Quit  Quit NVCap application. 

 Devices  Recognized devices list are displayed below “Devices” menu.  

 (Device name) If you click to check, capturing device is set to “(device name)”. 

 Options 

 Preview  Start / end previewing video. 

 Audio Format...  （Not used） 

 Video Capture Filter... Show capture filter dialog. 

 Video Capture Pin... Show capture pin dialog. 

 Capture 

 Start Capture  Start AVI capturing. 

 Stop Capture  Stop AVI capturing. 

 Capture Audio  （Not used） 

 Set Time Limit...  Set time limit of AVI capturing. 

 Screen Shot...  Save screenshot (.bmp format). 

 ExtensionUnit 

 I2C Transceiver... Display “I2C Transceiver” dialog. 

 I2C Stream Sender... Display “I2C Stream Sender” dialog. 

 Test   （Not used） 

 HW Reset  （Not used） 

 Reset Enable  （Not used） 

 Plugin   Call registered plugin DLLs.  

 Help 

 About...  Show version information dialog. 
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3.2.1. Plugin DLL Function 

【Figure 3.4】 Example of image quality adjustment by plugin DLL 

 

 NVCap has “plugin DLL function” for setting original function of camera on dialog form by using 

optional DLL. Adjustment of brightness, hue through I2C signal and so on is done by dialog called by 

plugin DLL.  

For more information about plugin DLL function please contact us. 
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3.3. NVCap Operation Method 

 

3.3.1. Preview Video 

1. Setting device setting (File -> Settings) 

 

 Setting device that capture from “Camera 1” to “Camera 4”.You can set up to four SVM-03U 

boards. Automatically set from recognized devices on PC by pressing “Set Auto”. NVCap opens 

device by pressing “OK” button. 

If you want to capture audio at the same time, you need to set device to “Audio”. But recording 

multi channel, audio is output only for device appointed to camera 0. 

Select the renderer used for window display in “Renderer”. It is able to recover from symptom 

by changing this setting in case of occurring error and failing previewing at the time of using 

high-resolution image sensor. 

You don’t need to configure settings at the time from the second starting on, because set 

contents are saved. At the time from the second starting, devices are opened caused by previous 

setting. 

But, if it is failed to open devices by the reason such as connected devices are changed, this 

setting is reset and you need to set anew. 
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2.  Transmit to initial setting to camera through I2C as necessary. 

(ExtensionUnit -> I2C Transceiver / ExtensionUnit -> I2C Stream Sender) 

The details such as I2C transfer methods are mentioned later. 

3. Start previewing. (Options -> Preview) 
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3.3.2. Capture Video (.avi format) 

1. Set format of output file. (File -> Settings) 

 

 Set the base file name of output file to “Base File name” used for capture(.avi) and 

screenshot(.bmp) and so on. For example, base file name is test.avi, file name made by capture is 

test_[date]_[time]_[ch].avi 

    file name made by screenshot is 

 test_[date]_[time]_[ch].bmp 

    Date and time are expressed as a numeral of six digits. 

2. If you want to display image during capturing, preview image. (refer to 3.3.1) 

3. Set time limit as needed. 

 

4. Start capturing. (Capture -> Start) 

In case of multi channel capturing, start capturing for all device in turn, we don’t guarantee about 

the time identity of the start frame. About the way of starting capture synchronized to trigger 
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signal, we mention at 3.3.6. 

5. Finish capturing. (Capture -> Stop) 

 

3.3.3. Save Screenshot (.bmp) 

1. Preview image. (refer to 3.3.1) 

2. Save screenshot in an arbitrary timing. (Capture -> Screen Shot) 

 

 Saved file path and file name are mentioned at the chapter of image capturing. At the case of 

using plural numbers of SVM-03U devices, screenshots are generated to different files for each 

device. Start capturing screenshot for all device in turn, we don’t guarantee about the time 

identity of the frame. 

 

3.3.4. Text-based I2C Transmitter 

 NVCap can transmit contents of configuration file used for our SV series and SVMCtl (SVM-03U 

utility software) (.txt / .dat form) to opened device through I2C bass on SVM-03U board. If plural 

numbers of devices are opened, file is transmitted to all devices in turn. About format of setting file, 

please refer to another document. 

  

1. Display I2C Stream Sender dialog. (ExtensionUnit -> I2C Stream Sender) 

 

2. Press “Send” button after selecting setting file. 

3. If the message of sending is automatically closed, I2C transmitting is finished.  
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Yet, if errors are occurred at the process of transmitting or Extension Unit DLL is not installed, 

error message is displayed. 

 

3.3.5. Dialog-based I2C Transceiver 

1. Display I2C Transceiver dialog. (ExtensionUnit -> I2C Transceiver) 

 

2. Select the device to communicate.  

 

3. Select “Send” or “Receive”.  

 

4. Set slave address (I2C Address).  

 

5. Set maximum receive bytes. (in case of receiving)  

 

6. Set sub address (Register Address) for number of items.  

(1 - 8 bytes, comma separated value) 
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7. Set sending data (Data) for number of items. (in case of sending)  

(1 - (30-(Register Address)) bytes,comma separated value) 

 

8. When you click “Execute” button, transmission or reception is carried out.  

Received data is input in “Data(Received)” box.  

 

 

*The number of packets that transmit or receive is up to ten. 

 If Resister Address is blank, it is skipped. 

*If the number of bytes that was really received is fewer than set(including reception error), indefinite 

value is displayed on dialog. 

*Format of I2C packet that received and transmitted is shown below. 

  



NVCap Software Manual 

NDC00046-V1.21 

 

 19 

 

【Figure 3.3】 I2C Packet Format 

 

S: Start Bit 

P: Stop Bit 

W: Write Bit (0) 

R: Read Bit (1) 

A: Ack 

N: Nack 

 

  



NVCap Software Manual 

NDC00046-V1.21 

 

 20 

 

4. FAQ 

 When starting an error dialog as below is shown. 

 

⇒SVM-03U board is not recognized by PC. Because it takes several seconds for starting 

SVM-03U board, you need to wait a while before starting NVCap after USB connected.  

 

 SVM-03U is recognized, but image is kept black screen and not displayed after starting preview.  

⇒ The follwing problems may be caused. 

 Connected by USB2.0 cable.  

（USB3.0 cable is required according to resolution and data rate.） 

 Image from camera is not received.  

（Please confirm blinking of “VSYNC” LED on board.） 

 Resolution set to SVM-03U board is different from the resolution of camera signal. 

 The board started in SVM-03 mode. 

 

 The dialog below is displayed by controlling ExtensionUnit menu.  

 

⇒ Installation of Extension Unit DLL is not succeeded. 

Please install it according to this document. 
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5. Recommended System Requirements 

OS: Windows 7, 8.1 / 64bit, 32bit 

CPU: Intel Core i5-4590 3.30 GHz or higher 

RAM: 8.0 GB or higher 

Connecting through USB 3.0 port 

 

- These are reccomended specification. NVCap would work on lower specs. 

- High-speed storage device such as SSD (Solid State Disk) should be used for multi channel 

capturing. 

 


